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ABSTRACT

The IoT-based pothole detection system is an intelligent solution designed to enhance road
safety and infrastructure management. It operates through a series of automated steps,
integrating sensors and communication modules to detect, alert, and report potholes in real
time. The system initiates with a 12V power supply, enabling an ultrasonic sensor to

continuously scan the road for surface irregularities.

Upon detecting a pothole, the vehicle halts immediately, and an onboard LCD displays an
alert, notifying the driver of the hazard. Simultaneously, a GPS module determines the
pothole's exact location, transmitting the coordinates via the Node MCU module to a

designated Gmail account for municipal authorities and maintenance teams.

Additionally, an ESP32 camera module streams live video, providing real-time visual
assessment of road conditions. By combining automated pothole detection, location tracking,
and live monitoring, this system ensures timely road repairs, reduces vehicular damage, and
enhances overall transportation safety. Its integration of loT-based technologies offers a

scalable and efficient approach to modern road maintenance and management.
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CHAPTER 1
INTRODUCTION

One of the major problems in developing countries is maintenance of roads. Well maintained
roads contribute a major portion to the country’s economy. Identification of pavement
distress such as potholes and humps not only help drivers to avoid accidents, helps to avoid
any vehicle damages, but also helps government authorities to maintain roads. This paper
discusses pothole detection methods that have been developed and also proposes a cost-
effective solution to identify and locate the potholes or humps on roads and provide alerts

to drivers to avoid accidents or vehicle damages.

The proposed system captures the geographical location coordinates of the potholes or
humps using a global positioning system receiver. Where the ultrasonic sensors are used to
identify the potholes or humps and it also measures their depth or height. An android
application is used to alert drivers so that precautionary measures can be taken to avoid any

misfortune.

Alerts are pinned on the google map in the application location of the pothole. With the
help of Bluetooth data is transferred to the mobile application in the form of raw data from
the sensor and at that particular trigger point where a pothole is detected the location will
get captured. Sensor data includes pothole depth and height, as well as geographic location,
which is stored in a cloud database. Governing authorities and drivers can benefit from this

valuable information.
1.1 OBJECTIVE OF THE PROJECT

Pothole detection is a crucial aspect of road maintenance and safety management, aiming to
identify and assess potholes on roads using advanced technologies. Potholes, caused by
factors like wear and tear, water penetration, and temperature changes, pose significant risks

to road users, including accidents, vehicle damage, and traffic disruption.

The project leverages methodologies such as image-based detection, where computer vision
and machine learning models analyze road images, and sensor-based detection, using

devices like accelerometers and gyroscopes to identify surface irregularities.



Integration of IoT, GPS, and hybrid systems enhances the accuracy and scalability of the
detection process. Despite challenges like variable lighting conditions, noisy data, and the

need for real-time processing, pothole detection systems play a vital role in improving road.

1.2 ORGANIZATION OF THE PROJECT

The initial phase of the IoT-based pothole detection system project involves defining its core
features and capabilities. This stage focuses on identifying the essential functionalities
required for effective pothole detection, driver alerting, and data documentation. Key
requirements include the real-time detection of potholes using an ultrasonic sensor as the
vehicle moves, an immediate mechanism to halt the vehicle's motion upon detection, and a

clear visual alert displayed on an onboard LCD screen to inform the driver.

Furthermore, the system must accurately record the geographical coordinates of detected
potholes using a Neo-6M GPS module. A critical aspect is the wireless transmission of this
GPS location data to a designated Gmail account via the Node MCU module, enabling
remote monitoring. Additionally, the system will incorporate an ESP32 camera module to
provide live video streaming of road conditions, offering visual context accessible remotely
through the Node MCU. The system will be powered by a 12V power supply, and the

vehicle's movement will be managed by a motor driver module.

The subsequent steps involve the detailed design and prototyping of the pothole detection
device. This includes the physical integration of hardware components such as the ultrasonic
sensor for road surface scanning, the motor driver for vehicle control, the LCD screen for
local alerts, the Neo-6M GPS module for location tracking, the Node MCU module for
wireless communication, and the ESP32 camera module for video streaming.
Simultaneously, the development team will work on the software architecture necessary to
process the data from the ultrasonic sensor, trigger alerts and vehicle halting, interface with
the GPS module, manage the wireless transmission of location data and video streams, and

control the LCD display.

Iterative prototyping will allow for testing the functionality of integrated components and
gathering feedback to refine the design and ensure it meets the functional requirements for

accurate and timely pothole detection and reporting.

During the extensive development and thorough testing phase, the primary focus will be

on ensuring the reliability and accuracy of the integrated system. Comprehensive testing will



be conducted under various simulated and real-world road conditions to evaluate the pothole
detection accuracy of the ultrasonic sensor and the responsiveness of the vehicle halting
mechanism. The accuracy of the GPS location data and the stability of the wireless
transmission of both GPS coordinates and live video streams will be rigorously assessed.

Factors such as power consumption, the durability of the hardware components under typical
usage, and the overall system stability will also be evaluated. Safety testing will ensure that

the vehicle halting mechanism operates effectively and reliably.

Following successful internal testing, a pilot testing phase will be initiated with a selected
group of users, such as transport authorities or road maintenance personnel. During this
phase, training materials will be provided to familiarize users with the operation of the
pothole detection system, including how to interpret the alerts, access the GPS data, and
view the live video streams. User-friendly interfaces or applications will be provided to
facilitate easy access to the collected data and video feeds, ensuring accessibility for
individuals with varying levels of technical proficiency. Feedback gathered during this pilot

testing phase will be crucial for identifying any remaining issues and areas for improvement.

The feedback collected from the pilot testing will be carefully analyzed to drive further
improvements to the pothole detection system before its broader deployment. This stage will
involve addressing any design inefficiencies or software bugs identified during testing to
enhance the device's performance, reliability, and overall user experience. Adjustments to
the sensitivity of the ultrasonic sensor, the efficiency of the wireless communication

protocols, or the stability of the video streaming will be implemented as needed.

The final phase encompasses the mass production and widespread distribution of the loT-
based pothole detection system. Efficient manufacturing processes will be established to
ensure cost-effectiveness while maintaining the quality of the device. Simultaneously,
comprehensive user manuals, instructional materials, and customer support systems will be

developed to assist new users with the setup and operation of the system.



CHAPTER 2
LITERATURE REVIEW

2.1 EXISTING SYSTEM

Pothole detection system using black box proposes that using a black box camera and
specified algorithm one can detect potholes in certain weather with accuracy of around 77%-
88%. However, this system can also detect manholes, crack, objects and vehicles due to
sensitivity and remove likewise to get potholes detected correctly. Real time pothole
detection using android smartphones with accelerometers which is using mobile based
accelerometers is used to detect the anomalies occurring on roads as data collected by the
smartphones gives the positive accuracy of around 90%. Algorithm specifies and gets the

data collection from android smartphones.

Pothole Detection using Machine Learning that is Implementing the technology of
Inception of V3 and Transfer Learning gets the flexible way for an application which
determines the shape, bump and type of anomaly on the road. Using convolution neural
networks and big data, the problem is handled well for the implementation and cost. The
aim of the research is to develop a device for identification of potholes and road conditions.
Thus, accurately and quickly detecting potholes is one of the important tasks for determining
proper strategies in ITS (Intelligent Transportation System) service and road management

system.

Several efforts have been made for developing a technology which can automatically detect
and recognize potholes. pothole detection system for real time identification of surface
irregularities on roads using Internet of Things (IoT). Device uses IoT sensors to detect
potholes in real time while an end user is driving vehicles on the road. The location of these
potholes would be available on a centrally hosted map which can be accessed by both end
users and civic authorities using the system as well as on mobile apps. By designing it this
way, it would function as both a warning system for all users as well as a database of potholes

along with their location for the authorities to address immediately.

The issues that potholes present may be alleviated by addressing the following two issues:
detecting and reporting potholes to the city, and warning motorists of existing potholes so

that they may be avoided. Potholes are a universal inconvenience that affect all roadways.
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As of May 2014, there have already been 13,000 potholes reported in the Washington D.C.
area for 2014.

Right now, the system only uses a g-force threshold to trigger pothole detection, but by
testing the system with actual data gathered from vehicles driving over potholes one could
properly profile the data using machine learning algorithms. This idea was explored by
Mednis, et al, in their experiments with potholes detection using smartphone accelerometers.
With this feature a user would be warned when a pothole is approaching on the road on
which they are traveling and they could take the necessary precautions to avoid it.

Challenges and problems to be solved.

Research questions have been led out to increase the knowledge to fill potholes or repair
it. Aim of this research is to develop software solutions for the road which are covered or
made with asphalt and provide useful solutions to the road potholes volume calculation for
the asphalt or concrete technology implement and cover or repair it. In order to judge
ultrasonic sensor's sensitivity and usefulness to avoid the road potholes and identify the

measurements in a simulated environment were carried out.

The following environments were used for measurements: a bright light environment; b
heightened humidity environment; c variable height environment. Graph shows that distance
from ultrasonic sensor till object is more than 100 cm in some places; besides, despite
possibilities for visual detection of imitated road potholes, location anomalies which are

fixed in the district will not allow precise data about pothole’s depth.

The following pothole volume calculation algorithm has been developed in order to
implement road potholes volume detection in real-world situations. To determine which
file's data array is subject to further processing; determine the min and the max values; for

the measurements are sliced down into layers and taken one step.

The pothole binary image is created; count the previously calculated ones and multiplied
by a step of one layer to get the pothole volume is in centimetre units. If there are severe
weather events, transportation infrastructure can be directly or indirectly damaged. This can
pose a threat to human safety, and cause significant disruptions related to the economic and
social impacts of flooding. To address these issues, in this study, the implementation of
integration with road and environmental monitoring as support to road monitoring is based

on the Internet of Things as a supervising system. This system is an integration of several
5



sensor devices connected to embedded systems and communication devices that are attached
to the vehicle. Data is sent to the data centre and evaluated using machine learning

algorithms that can analyse the collected data.

The categorization of SVM and DT in the computation using Confusion Matrix shows that
SVM has an accuracy rate of 98% with an error rate of 10-hole holes and eight bumps, while
DT has an error value of 4 for holes and 1 for bump and eight bump readings and 11 holes.
Data from Vaa MSN is sent via the MQTT protocol to the Big Data platform and analysed

by decision trees and machine support vector algorithms.

2.2 PROPOSED SYSTEM

The proposed IoT-based pothole detection system is designed to provide an automated,
efficient, and real-time solution for identifying and reporting potholes on roadways. The
system comprises a combination of electronic components, sensors, and communication
modules integrated into a vehicle-mounted unit. The key objective is to improve road safety
by providing real-time alerts to drivers and transmitting pothole location data to relevant

authorities for timely maintenance.

The core component of the proposed system is an ultrasonic sensor, which continuously
scans the road surface to detect potholes. This sensor is mounted on a vehicle and actively
measures the distance between the vehicle and the road. Any significant deviation indicating
a pothole triggers the system’s response mechanism. Upon detection, the system stops the
vehicle momentarily to alert the driver, minimizing potential damage and accidents. An
onboard LCD screen provides a real-time notification of the detected pothole, ensuring that

vehicle occupants are informed immediately.

To enhance the system’s functionality, a Neo-6M GPS module is incorporated to capture
the exact geographical coordinates of the pothole. This information is crucial for
documentation and maintenance planning. The captured location data is transmitted
wirelessly to a designated email address via the Node MCU module, ensuring that road
maintenance teams receive real-time alerts. Additionally, an ESP32 camera module is
integrated into the system to provide live video streaming.

This feature enables users to visually inspect road conditions remotely, adding another layer
of verification before maintenance decisions are made. The communication between

components is managed through the Node MCU module, which connects to the internet to

6



facilitate the seamless transmission of pothole data and live video feeds. The proposed
system also has the potential for future enhancements, including machine learning
algorithms for advanced road condition analysis and integration with cloud-based databases

for large-scale data collection.

By leveraging IoT technology, this system offers comprehensive approach to improving
road infrastructure, reducing vehicle maintenance costs, and enhancing overall driving
safety. The implementation of this system can significantly contribute to smart city
initiatives, where automated road monitoring and predictive maintenance strategies can be

employed to keep roads in optimal condition.

By deploying this system in municipal, commercial, and personal vehicles, authorities and
individuals can collaboratively work towards maintaining safer road networks. The
combination of real-time alerts, precise GPS tracking, and live video streaming ensures a
holistic approach to addressing the persistent issue of potholes, making this system a

valuable asset for modern transportation infrastructure.

2.3 INTRODUCTION TO EMBEDDED SYSTEM

An embedded system is a combination of computer hardware and software designed for a
specific function or functions within a larger system. The systems can be programmable or
with fixed functionality. Industrial machines, consumer electronics, agricultural and process

industry devices, automobiles, medical equipment, cameras, household appliances,

Operating System

input l output

> ‘ processing. I A motor [ "2

FIG: 2.1 Os of Emebeeded system
While embedded systems are computing systems, they can range from having no user
interface (UI) -- for example, on devices in which the system is designed to perform a single
task -- to complex graphical user interfaces (GUIs), such as in mobile devices. User interface
scan include buttons, LEDs and touchscreen sensing. Some systems use remote user

interfaces as well.


https://searchapparchitecture.techtarget.com/definition/user-interface-UI
https://searchapparchitecture.techtarget.com/definition/user-interface-UI
https://searchapparchitecture.techtarget.com/definition/user-interface-UI
https://searchwindevelopment.techtarget.com/definition/GUI
https://searchwindevelopment.techtarget.com/definition/GUI
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2.3.1 History of embedded systems

Embedded systems date back to the 1960s. Charles Stark Draper developed an integrated
circuit (IC) in 1961 to reduce the size and weight of the Apollo Guidance Computer, the
digital system installed on the Apollo Command Module and Lunar Module. The first

computer to use ICs, it helped astronauts collect real-time flight data.

In 1965, Autonoetic, now a part of Boeing, developed the D-17B, the computer used in the
Minuteman I missile guidance system. It is widely recognized as the first mass-produced
embedded system. When the Minuteman II went into production in 1966, the D-17B was
replaced with the NS-17 missile guidance system, known for its high-volume use of
integrated circuits. In 1968, the first embedded system for a vehicle was released; the

Volkswagen 1600 used a microprocessor to control its electronic fuel injection system.

Also, in 1971, Intel released what is widely recognized as the first commercially available
processor, the 4004. The 4-bit microprocessor was designed for use in calculators and small
electronics, though it required eternal memory and support chips. The 8-bit Intel 8008,
released in 1972, had 16 KB of memory; the Intel 8080 followed in 1974 with 64 KB of
memory. The 8080's successor, x86 series, was released in 1978 and is still largely in use
today. In 1987, the first embedded operating system, the real-time VxWorks, was released
by Wind River, followed by Microsoft's Windows Embedded CE in 1996. By the late 1990s,
the first embedded Linux products began to appear.

The late 1980s saw the emergence of embedded operating systems, with Wind River
releasing the real-time VxWorks in 1987. Microsoft followed suit in 1996 with Windows
Embedded CE. By the late 1990s, the first embedded Linux products began to appear,

offering a flexible and customizable alternative to proprietary operating systems.

Today, embedded systems are ubiquitous, powering a wide range of applications, from
consumer electronics and industrial control systems to medical devices and autonomous
vehicles. As the Internet of Things (IoT) continues to expand, the demand for sophisticated
embedded systems will only continue to grow, driving innovation and advancements in

this exciting field.


https://searchdatacenter.techtarget.com/definition/Linux-operating-system
https://searchdatacenter.techtarget.com/definition/Linux-operating-system
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2.3.2 Characteristics of embedded systems

The main characteristic of embedded systems is that they are task specific. They perform a
single task within a larger system. For example, a mobile phone is not an embedded system,
it is a combination of embedded systems that together allow it to perform a variety of

general-purpose tasks.

FIG: 2.2 Embedded systems

The embedded systems within it perform specialized functions. For example, the GUI
performs the singular function of allowing the user to interface with the device. In short,

they are programmable computers, but designed for specific purposes, not general ones.

The hardware of embedded systems is based around microprocessors and microcontrollers.
Microprocessors are very similar to microcontrollers, and generally refer to a CPU that is
integrated with other basic computing components such as memory chips and digital signal

processors (DSP). Microcontrollers have those components built into one chip.

Additionally, embedded systems can include the following characteristics:

«  Comprised of hardware, software and firmware;

« Embedded in a larger system to perform a specific function as they are built for
specialized tasks within the system, not various tasks;

«  Either microprocessor-based or microcontroller-based -- both are integrated circuits that
give the system compute power;

« Often used for sensing and real-time computing in internet of things (IoT) devices --

devices that are internet-connected and do not require a user to operate;


https://internetofthingsagenda.techtarget.com/definition/microcontroller
https://internetofthingsagenda.techtarget.com/definition/microcontroller
https://internetofthingsagenda.techtarget.com/definition/microcontroller
https://internetofthingsagenda.techtarget.com/definition/microcontroller
https://internetofthingsagenda.techtarget.com/definition/microcontroller
https://whatis.techtarget.com/definition/digital-signal-processing-DSP
https://whatis.techtarget.com/definition/digital-signal-processing-DSP
https://whatis.techtarget.com/definition/digital-signal-processing-DSP
https://whatis.techtarget.com/definition/digital-signal-processing-DSP
https://internetofthingsagenda.techtarget.com/definition/Internet-of-Things-IoT
https://internetofthingsagenda.techtarget.com/definition/Internet-of-Things-IoT
https://internetofthingsagenda.techtarget.com/definition/Internet-of-Things-IoT

Vary in complexity and in function, which affects the type of software, firmware and
hardware they use.
Often required to perform their function under a time constraint to keep the larger system

functioning properly.

Embedded systems vary in complexity, but generally consist of three main elements:

Hardware. The hardware of embedded systems is based around microprocessors and
microcontrollers. Microprocessors are very similar to microcontrollers, and generally
refer to a CPU that is integrated with other basic computing components such as memory
chips and digital signal processors (DSP). Microcontrollers have those components built

into one chip.

Software. Software for embedded systems can vary in complexity. However, industrial
grade microcontrollers and embedded 10T systems generally run very simple software

that requires little memory.

Firmware. Embedded firmware is usually used in more complex embedded systems to
connect the software to the hardware. Firmware is the software that interfaces directly

with the hardware.

SOFTWARE HARDWARE APPLICATION

Fig: 2.3 Blocks Of Embedded Systems

2.4 WHY EMBEDDED?

An embedded system is a computer system with a particular defined function within a larger

mechanical or electrical system. They control many devices in common use. They consume

low power, are of a small size and their cost is low per-unit. Modern embedded systems are

often based on micro-controllers.
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A micro-controller is a small computer on a single integrated circuit which contains a
processor core, memory, and programmable input and output peripherals. As Embedded
system is dedicated to perform specific tasks therefore, they can be optimized to reduce the

size and cost of the product and increase the reliability and performance.

Embedded Systems has brought about a revolution in Science. It is also a part of a Internet
of Things (IoT) — a technology in which objects, animals or people are provided with unique
identifiers and the ability to transfer data over a network without requiring humanto-human

or human-to-computer interaction.

Well this is just one good thing about IoT. We can monitor Pollution Levels, we can control
the intensity of street lights as per the season and weather requirements, [oT can also provide
the parents with real-time information about their baby’s breathing, skin temperature, body
position, and activity level on their smartphones and many other applications which can

make our life easy.

Fig:2.4 Embedded systems hardware

IoT-enabled smart home systems can automatically adjust lighting, temperature, and security
settings to create a comfortable and secure living environment. In the healthcare sector, [oT
devices can track patients' vital signs, medication adherence, and other health metrics,
enabling remote monitoring and timely interventions. IoT can also optimize industrial
processes, such as predictive maintenance, quality control, and supply chain management,
leading to increased efficiency and reduced costs. Furthermore, IoT can enhance public

safety by monitoring traffic flow, detecting accidents, and alerting emergency services.
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2.5 DESIGN APPROACHES

A system designed with the embedding of hardware and software together for a specific
function with a larger area is an embedded system design. In embedded system design, a
microcontroller plays a vital role.

Micro-controller is based on Harvard architecture, it is an important component of an
embedded system. External processor, internal memory, and i/o components are interfaced

with the microcontroller.

It occupies less area and less power consumption. The application of microcontrollers is
MP3 and washing machines. Critical Embedded Systems (CES) are systems in which
failures are potentially catastrophic and, therefore, hard constraints are imposed on them. In

the last years the amount of software accommodated within CES has considerably changed.

For example, in smart cars the amount of software has grown about 100 times compared to
previous years. This change means that software design for these systems is also bounded
to hard constrains (e.g., high security and performance). Along the evolution of CES, the
approaches for designing them are also changing rapidly, so as to fit the specialized need of

CES. Thus, a broad understanding of such approaches is missing.

Steps in the Embedded System Design Process
The different steps in the embedded system design flow/flow diagram include the following.
Specification: The first step in the process, where you define the requirements that the

system must meet

Abstraction

& 2

Hardware - Software
Architecture

Extra Functional Properties

"

System Related Family of
Design

@

Modular Design

@

Mapping

«

User Interface Design

L 2

Refinement

©Elprocus.com

Fig: 2.5 Embedded design-process-steps
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Hardware and software partitioning: You divide the system into hardware and software
components

Hardware and software design: You design approach the hardware and software
independently

Hardware and software integration: You integrate the hardware and software, and decide
how and when to resolve bugs

Software testing: You test the software to detect vulnerabilities

User interface design: You design the interface between the CPU software and the digital
interface logic, and between the digital and analog sides of the interface

Abstraction

In this stage the problem related to the system is abstracted.

Hardware — Software Architecture

Proper knowledge of hardware and software to be known before starting any design process.
Extra Functional Properties

Extra functions to be implemented are to be understood completely from the main design.
System Related Family of Design

When designing a system, one should refer to a previous system-related family of design.

i N

Embedded system

Software

Application | | Embedded 0S| © o *

Input uutput

Hardware

Embedded Peripheral | o o o
microprocessor device

- /

Fig: 2.6 Hardware and software of embedded system
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Table: 2.1 Design parameters and functions of an embedded system

Design Metrics / Design
Parameters of

Embedded System

an

Function

Power Dissipation

Always maintained low

Performance

Should be high

Process Deadlines

The  process/task should
be completed within a
specified time.

Manufacturing Cost

Should be maintained.

Engineering Cost

It is the cost for the edit-test-
debug of hardware and
software.

Size

Size is defined in terms of
memory  RAM/ROM/Flash
Memory/Physical Memory.

Prototype

It is the total time taken for
developing a system and
testing it.

Safety

System safety should be taken
like phone locking, user safety
like engine breaks down safety
measure must be taken

Maintenance

Proper maintenance of the
system must be taken, in order
to avoid system failure.

Time to market

It is the time taken for the
product/system developed to
be launched into the market.




Modular Design

Separate module designs must be made so that they can be used later on when required.
Mapping

Based on software mapping is done. For example, data flow and program flow are mapped
into one.

User Interface Design

In user interface design it depends on user requirements, environment analysis and function
of the system. For example, on a mobile phone if we want to reduce the power consumption
of mobile phones, we take care of other parameters, so that power consumption can be
reduced.

Refinement

Every component and module must be refined appropriately so that the software team can
understand

Architectural description language is used to describe the software design.

e Control Hierarchy

e Data structure and hierarchy

e Software Procedure.

In user interface design it depends on user requirements, environment analysis and function
of the system. For example, on a mobile phone if we want to reduce the power consumption
of mobile phones, we take care of other parameters, so that power consumption can be

reduced. WHO has identified formulations for their local preparation.

Embedded systems are used in a variety of technologies across industries. Some examples
include:
Automobiles. Modern cars commonly consist of many computers or embedded systems,

designed to perform different tasks within the vehicle.

Some of these systems perform basic utility function and others provide entertainment or
user-facing functions. Some embedded systems in consumer vehicles include cruise control,
backup sensors, suspension control, navigation systems and airbag systems.

« Mobile phones. These consist of many embedded systems, including GUI software and

hardware, operating systems, cameras, microphones and USB I/O modules.
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« Industrial machines. They can contain embedded systems, like sensors, and can be
embedded systems themselves. Industrial machines often have embedded automation

systems that perform specific monitoring and control functions.

i,

\® & i ! y
Smart \‘\

transport

== 4—
Acrospace
/ Yol
"\,_b f’/ .
HCI

Fig: 2.7 Applications of embedded systems

+  Medical equipment. These may contain embedded systems like sensors and control
mechanisms. Medical equipment, such as industrial machines, also must be very user
friendly, so that human health isn't jeopardized by preventable machine mistakes. This

means they'll often include a more complex OS and GUI designed for an appropriate UI.

« The choice of components for the WHO-recommended handrub formulations takes into
account cost constraints and microbicidal activity. The following two formulations are
recommended for local production with a maximum of 50 litres per lot to ensure safety
in production and storage.Formulation 1: 80% ethanol or 75% isopropanol, 1.45%
glycerol, and 0.125% hydrogen peroxide, with sterile distilled or boiled water as the
remaining volume. Formulation 2: 70% ethanol or 60% isopropanol, 1.45% glycerol,
and 0.125% hydrogen peroxide, with sterile distilled or boiled water as the remaining
volume. These formulations have been shown to be effective against a wide range of
microorganisms, including bacteria, viruses, and fungi, and are suitable for use in

healthcare settings, including hospitals, clinics, and community health centers.
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2.6 COMBINATION OF LOGIC DEVICES
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Fig: 2.8 Logic Gates

Logic gates are physical devices that use combinational logic to switch an electrical one
(“1”) or zero (“0”) to downstream blocks in digital design. Combinational logic uses those
bits to send or receive data within embedded systems. Data bits build into digital words used
to communicate with other design blocks within the system.

Digital bits and words do this with logic gates in an organized fashion using dedicated
address, data, or control signal nodes. Logic gates are the physical devices that enable

processing of many 1’s and 0’s.

Logic families are collections of integrated circuits containing logic gates that perform
functions needed by embedded systems to communicate with one another to drive the
design. Logic gates are organized into families relative to the type of material and its

operational characteristics.

Most logic gates are made from silicon, although some utilize gallium arsenide or other
semiconductor materials. The semiconductor material is doped for organization into layers.
The doped layers drive power capabilities and typical impedances at input or outputs of each

gate.
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CHAPTER 3
HARDWARE REQUIREMENTS

3.1 EMBEDDED SYSTEM HARDWARE

Embedded system hardware can be microprocessor- or microcontroller-based. In either case,
an integrated circuit is at the heart of the product that is generally designed to carry out real
time computing. Microprocessors are visually indistinguishable from microcontrollers.
However, the microprocessor only implements a central processing unit (CPU) and, thus,
requires the addition of other components such as memory chips. Conversely,

microcontrollers are designed as self-contained systems.

Microcontrollers include not only a CPU, but also memory and peripherals such as flash
memory, RAM or serial communication ports. Because microcontrollers tend to implement
full (if relatively low computer power) systems, they are frequently used on more complex
tasks. For example, microcontrollers are used in the operations of vehicles, robots, medical

devices and home appliances.

At the higher end of microcontroller capability, the term System on a chip (SOC) is often
used, although there's no exact delineation in terms of RAM, clock speed, power

consumption and so on.

It is one of the characteristics of embedded and cyber-physical systems that both hardware
and software must be taken into account. The reuse of available hard- and software
components is at the heart of the platform-based design methodology. Consistent with the
need to consider available hardware components and with the design information flow, we

are now going to describe some of the essentials of embedded system hardware.

Hardware for embedded systems is much less standardized than hardware for personal
computers. Due to the huge variety of embedded system hardware, it is impossible to provide
a comprehensive overview of all types of hardware components. Nevertheless, we will try

to provide a survey of some of the essential components which can be found in most systems.

The choice of components for the WHO-recommended hand rub formulations takes into

account cost constraints and microbicidal activity. The following two formulations are
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recommended for local production with a maximum of 50 litres per lot to ensure safety in

production and storage.

Markets and Markets, a business to business (B2B) research firm, predicts that the
embedded market will be worth $116.2 billion by 2025. Chip manufacturers for embedded
systems include many well-known technology companies, such as Apple, IBM, Intel and
Texas Instruments, as well as numerous other companies less familiar to those outside the

field.

EMBEDDED SYSTEM HARDWARE

laput Devices
luterfacing’
Driver Cirewits

Power Sapply, Rest and Oscillator Clrowit

Fig: 3.1 Embedded Systems Hardware Block Diagram
The expected growth is partially due to the continued investment in artificial intelligence
(AI), mobile computing and the need for chips designed for that high-level processing. To
be used efficiently, all computer software needs certain hardware components or other
software resources to be present on a computer. These prerequisites are known as (computer)

system requirements and are often used as a guideline as opposed to an absolute rule.

Most software defines two sets of system requirements: minimum and recommended. With

increasing demand for higher processing power and resources in newer versions of software,
system requirements tend to increase over time. Industry analysts suggest that this trend
plays a bigger part in driving upgrades to existing computer systems than technological
advancements.
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A second meaning of the term of system requirements, is a generalisation of this first
definition, giving the requirements to be met in the design of a system or subsystem.

Often manufacturers of games will provide the consumer with a set of requirements that are
different from those that are needed to run a software. These requirements are usually called
the recommended requirements. These requirements are almost always of a significantly
higher level than the minimum requirements, and represent the ideal situation in which to

run the software.

Generally speaking, this is a better guideline than minimum system requirements in order
to have a fully usable and enjoyable experience with that software. The most common set of
requirements defined by any operating system or software application is the physical
computer resources, also known as hardware, A hardware requirements list is often

accompanied by a hardware compatibility list(HCL), especially in case of operating systems.

An HCL lists tested, compatible, and sometimes incompatible hardware devices for a
particular operating system or application. The following subsections discuss the various

aspects of hardware requirements.

Architecture

All computer operating systems are designed for a particular computer architecture. Most
software applications are limited to particular operating systems running on particular
architectures. Although architecture-independent operating systems and applications exist,
most need to be recompiled to run on a new architecture. See also a list of common operating

systems and their supporting architectures.

Processing power

The power of the central processing unit (CPU) is a fundamental system requirement for any
software. Most software running onx86 architecture define processing power as the model
and the clock speed of the CPU. Many other features of a CPU that influence its speed and

power, like bus speed, cache, and MIPS are often ignored.

This definition of power is often erroneous, as AMD Athlon and Intel Pentium CPUs at
similar clock speed often have different throughput speeds. Intel Pentium CPUs have

enjoyed a considerable degree of popularity, and are often mentioned in this category.
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Memory
All software, when run, resides in the random access memory(RAM) of a computer. Memory
requirements are defined after considering demands of the application, operating system,

supporting software and files, and other running processes.

Optimal performance of other unrelated software running on a multi-tasking computer

system is also considered when defining this requirement.

Secondary storage
Data storage device requirements vary, depending on the size of software installation,
temporary files created and maintained while installing or running the software, and possible

use of swap space(if RAM is insufficient).

Display adapter

Software requiring a better than average computer graphics display, like graphics editor sand
high-endgames, often define high-end display adapt ersin the system requirements.
Peripherals

Some software applications need to make extensive and/or special use of some peripherals,
demanding the higher performance or functionality of such peripherals. Such peripherals

include CD-ROM drives, keyboards, pointing devices, network devices, etc.

Basic Structure of an Embedded System

The following illustration shows the basic structure of an embedded system
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Fig: 3.2 Peripherals of Embedded Systems
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CHAPTER 4

SOFTWARE REQUIREMENTS
4.1 EMBEDDED SYSTEM SOFTWARE

A typical industrial microcontroller is unsophisticated compared to the typical enterprise
desktop computer and generally depends on a simpler, less-memory-intensive program
environment. The simplest devices run on bare metal and are programmed directly using the
chip CPU's machine code language. Often, embedded systems use operating systems or
language platforms tailored to embedded use, particularly where real-time operating

environments must be served.

At higher levels of chip capability, such as those found in SoCs, designers have increasingly
decided the systems are generally fast enough and the tasks tolerant of slight variations in
reaction time that near-real-time approaches are suitable. In these instances, stripped-down
versions of the Linux operating system are commonly deployed, although other operating
systems have been pared down to run on embedded systems, including Embedded Java and

Windows [oT (formerly Windows Embedded).

Generally, storage of programs and operating systems on embedded devices make use of
either flash or rewritable flash memory.

These activities include:

e Setting up a cloud service provider such as Amazon Web Services, Google Cloud, etc

e Set up private and public keys along with a device certificate.

e Write a device policy for devices connecting to the cloud service

e (Connect an embedded system to the cloud service

e Transmit and receive information to the cloud

e Build a basic dashboard to examine data in the cloud and control the device

If developers are able to do these things, they will have built a good foundation from which
to master cloud connectivity for their embedded systems. Software requirements deal with
defining software resource requirements and prerequisites that need to be installed on a

computer to provide optimal functioning of an application.

These requirements or prerequisites are generally not included in the software installation

package and need to be installed separately before the software is installed.
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Platform

A computing platform describes some sort of framework, either in hardware or software,
which allows software to run. Typical platforms include a computer's architecture, operating
system, or programming languages and their run time libraries. Operating system is one of

the requirements mentioned when defining system requirements (software).

Software may not be compatible with different versions of same line of operating systems,
although some measure of backward compatibility is often maintained. For example, most
software designed for Microsoft Windows XP does not run on Microsoft Windows 98,

although the converse is not always true.

Similarly, software designed using newer features of Linux Kernelv2.6 generally does not
run or compile properly (or at all) on Linux distributions using Kernel v2.2 or v

APIs and drivers

Software making extensive use of special hardware devices, like high-end display adapters,
needs special API or newer device drivers. A good example is Direct X, which is a collection
of APIs for handling tasks related to multimedia, especially game programming, on
Microsoft platforms.

Steps to Download and Install Arduino Software

Step 1: First you must have your Arduino board (you can choose your favourite board) and
a USB cable. In case you use Arduino UNO, Arduino Due milanove, Nano, Arduino Mega
2560, or Diecimila, you will need a standard USB cable (A plug to B plug).

Step 2: Download Arduino IDE Software.

You can get different versions of Arduino IDE from the Download page on the Arduino
Official website.

Step 3: Power up your board.

The Arduino Uno, Mega, Due milanove and Arduino Nano automatically draw power from
either, the USB connection to the computer or an external power supply.

Step 4: Launch Arduino IDE.

After your Arduino IDE software is downloaded, you need to unzip the folder. Inside the
folder, you can find the application icon with an infinity label (application.exe).

Step 5: Open your first project.

Step 6: Select your Arduino board.

To avoid any error while uploading your program to the board, you must select the correct

Arduino board name, which matches with the board connected to your computer.
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Step 7: Select your serial port.

Select the serial device of the Arduino board.

Step 8: Upload the program to your board.

Before explaining how we can upload our program to the board, we must demonstrate the

function of each symbol appearing in the Arduino IDE toolbar.
4.2 RESEARCH

The embedded systems industry was born with the invention of microcontrollers and since
then it has evolved into various forms, from primarily being designed for machine control
applications to various other new verticals with the convergence of communications. Today
it spans right form small metering devices to the multi-functional smartphones. I will cover
the areas that are currently focused for development in embedded systems and state what

are the ongoing research opportunities in that particular area.

Security remains a great challenge even today. Ongoing Research is to sustain physical
tampering, mechanisms to trust the software, authenticate the data and securely
communicate over internet. With the advent of 10T/IoE, not only the number devices will
continue to increase but also will the number of possible attack vectors. Many challenges

remain ahead to get the connected devices on a billion scale.

Wi-Fi, BLE, ZigBee, Thread, ANT, etc have been adapted by embedded system experts
from considerable time. Head-on competition between these groups is in progress to
determine as to who will emerge as the best solution provider to this huge estimated market
of IoT/IoE. 4G/5G on low power devices is the ongoing experimentation which will make

embedded systems easily and robustly connect to the internet.

Communication using GSM/LTE in licensed/unlicensed communication bands with the
cloud can change the ball game of IoE all together. Various type of volatile/non-volatile
memories with variable sizes and speeds are widely available today. Research is more
towards organizing them in best possible architecture to reach closer to the design goal of

optimal power-performance-cost.

Power/Battery management has been under focus for some time. Usage of renewable
resources to power device's lifetime is currently the challenge that is tried to address;
especially for wearables. Optimal power usage to get Longer Battery Life with new

Hardware/Software architectural designs will continue for some time. System Multicore
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(Symmetric/Asymmetric) architectures are experimented since long. Addition of GPUs to

systems for VR/Gaming/Machine learning is addressed currently.

Programmable SOCs (PSOCs) - (Configurable Hardware Capability) have been there for a
long time now, but some has not yet gained momentum. Application-specific computer
architectures is also in the pipeline in order to optimize the design matrix of power
performance-cost. Real-time on-board Image/Video/Audio processing, feature enabled
cameras, on board machine learning are all currently experimented with varied approaches.
Commercialization of these technologies has already started but there is still some time to
get the best out of these technologies and there is lot of scope to make them more user

friendly.

Other than this, hardening of modular software functionalities (Yes lot of architectures are
coming up with hardware performing redundant software functionalities). Ongoing research
is to analyse the performance and determine the applications where this strategy can be

fruitful.

Wireless Sensor Networks, Machine to Machine Communication/Interaction, Human
Computer Interaction, Security Gateway protocols are still being improved. Light weight
algorithms with optimal security will be targeted for embedded systems.

Real Time Operating Systems (RTOS)

Many companies are backing at least one Real Time Open-Source Operating System and
there are many out there. Challenge is to cover the wide span of devices, there functionalities

and variety of applications.
4.3 ARDUINO SOFTWARE

Arduino IDE (Integrated Development Environment) is required to program the Arduino
Uno board. Download it here.

Programming Arduino

Once Arduino IDE is installed on the computer, connect the board with computer using USB
cable. Now open the Arduino IDE and choose the correct board by selecting
Tools>Boards>Arduino/Genuine Uno, and choose the correct Port by selecting Tools>Port.
Arduino Uno is programmed using Arduino programming language based on Wiring. To get
it started with Arduino Uno board and blink the built-in LED, load the example code by
selecting Files>Examples>Basics>Blink. Once the example code (also shown below) is

loaded into your IDE, click on the ‘upload’ button given on the top bar. Once the upload is
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finished, you should see the Arduino’s built-in LED blinking. Below is the example code
for blinking:

Arduino Installation

After learning about the main parts of the Arduino UNO board, we are ready to learn how
to set up the Arduino IDE. Once we learn this, we will be ready to upload our program on
the Arduino board.

In this section, we will learn in easy steps, how to set up the Arduino IDE on our computer
and prepare the board to receive the program via USB cable.

Step 1: First you must have your Arduino board (you can choose your favorite board) and a
USB cable. In case you use Arduino UNO, Arduino Duemilanove, Nano, Arduino Mega
2560, or Diecimila, you will need a standard USB cable (A plug to B plug), the kind you

would connect to a USB printer as shown in the following image.

In case you use Arduino Nano, you will need an A to Mini-B cable instead as shown in the

following image

Step 2: Download Arduino IDE Software.

You can get different versions of Arduino IDE from the Download page on the Arduino
Official website.

You must select your software, which is compatible with your operating system (Windows,

IOS, or Linux). After your file download is complete, unzip the file.
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Step 3: Power up your board.

The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from

either, the USB connection to the computer or an external power supply. If you are using an

Arduino Diecimila, you have to make sure that the board is configured to draw power from

the USB connection.

The power source is selected with a jumper, a small piece of plastic that fits onto two of

the three pins between the USB and power jacks. Check that it is on the two pins closest to

the USB port.

f

Opening arduino-nightly-windows.zip
You have chosen to open:

g arduino-nightly-windows.zip

which is: WinRAR ZIP archive (148 MB)
from: https://downloads.arduino.cc

What should Firefox do with this file?

Open with tWinRAR archiver (default) v

|| Do this automatically for files like this from now on.

[ OK J ‘ Cancel

Connect the Arduino board to your computer using the USB cable. The green power LED

(labeled PWR) should glow.

Step 4: Launch Arduino IDE.

After your Arduino IDE software is downloaded, you need to unzip the folder. Inside the

folder, you can find the application icon with an infinity label (application.exe). Double click

the icon to start the IDE

27



Step 5: Open your first project.

Once the software starts, you have two options:

@‘\)'; » Computer » Local Disk (C:) » Program Files » Arduino »

Orgenize Inchude in library » Share with » Burn New folder
¥ Fovorites lame Date modified T
B Deskrop dnvers id
# Downloads examples
| Recent Places herdware e
java
o Libraries b
¢ Documents hibrares
o' Music reference
o Pictures tools / )
E Videos ’:‘ ardusno Appheat
@ srduno_debug
& Computer b Cygicony-2.40 4
& Local Disk (C) v cygwinl.dil |
s MTC MASTER (Dv) & Wbuskd 41l 14
i INFORMATION TECHNOLOG reviteony iF
b otSerial.dil u
S Network “3 unmstall |
[J Create a new project.
[J Open an existing project example.
To create a new project, select File --> New
= ra =)
2 sketch novi9 | Arduine 105 SRR % D shetch noviSe | Arduino 105 ol
[Fie) £ Sketeh Tools Melp File Edt Sketch Tools Hep
e CuleN
Open CuleO
Sketchbook »
Erxamples » 2
Clote CuleW
Seve Cules
Seve As Ctrle Shift §
Uplead Culel
Upload Using Programmer  Ctrle Shifte U
Page Setup Cuebe Snfte P
Priret Culep
Preferences Ctrle Comma
Qun CuieQ
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To open an existing project example, select File -> Example -> Basics -> Blink.
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Savetnevun
Bued

e

Q) Ansey
o Communcmen
05 Contant Taae
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O Deapley —

[

T birk | Ao 104
B (de Shareh Town by

8 Wnegs

Mew vl

o U

© Wt | A 100 Lo |
fn 1t Shen Towm Mely
P ’ 20 B8

Cyper Cohe
% 30 Larterkn
Aedonrlid
LI .

Chise Cobewy

Tomnay .

Save Cole b Ai et bapee
e M oo Shie s Adutra o000
Upla st Ol Al ot 1L IM0
Ugload Uning Programmes  Cite el Aded an B
Adad it torelieel

Vage Setup (e \hine P
» " Ad ot ABFEN |

Prue Chbed
Adefron BAMTY

Frotwery o0 Colhe Comme Asal vt W e
Afnm ST
Adef v STMAMGLD
Aded st VI

Quit (e

ADX
AN ot
arper
At
Bowrve
Capactroeentes
Dewlimple
Degled
DELOIIC
CS0200 mudetor
v

Here, we are selecting just one of the examples with the name Blink. It turns the LED on
and off with some time delay. You can select any other example from the list.

Step 6: Select your Arduino board.

To avoid any error while uploading your program to the board, you must select the correct
Arduino board name, which matches with the board connected to your computer.

Go to Tools -> Board and select your board.

Teensy32/31
Teensy30
TeensyLC

2 Blink | Arduino 106 Teensy 20

File Edit Sketch (Tools) Help Teensy++ 20

. Jno
Auto Format Crts T Acboieny
e Arduino Duemisnove w/ ATmega328

Arduino Diecimila or Duemilanove w/ ATmegal6s
Arduino Nano w/ ATmega328

Arduino Nano w/ ATmegal68

Board: “Arduino Uno”
Serial Port

Arduino Esplora
Arduino

— Arduino Mini w/ ATmega328

Burn Bootloader

BT w/ ATmegai2s
rduino BT w/ ATmegal68

LilyPad Arduine USE

LilyPad Arduino w/ ATmega32s

LilyPad Arduino w/ ATmegal6s

Ardu i (SV, 16 MHz) w/ ATmege28
Ardu i (V. 16 MHz) w/ ATmegal6s
i © Mini (33V, 8 MH2) w/ ATmegai2s

i 33V, 8 MH2) w/ ATmegal6s
Arduino NG or oider w/ ATmegalé8
Arduine NG or older w/ ATmegad

Arduino Robot Control

Arduino Robot Motor
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Here, we have selected Arduino Uno board according to our tutorial, but you must select the

name matching the board that you are using.

Step 7: Select your serial port.

Select the serial device of the Arduino board. Go to Tools -> Serial Port menu. This is likely
to be COM3 or higher (COM1 and COM2 are usually reserved for hardware serial ports).
To find out, you can disconnect your Arduino board and re-open the menu, the entry that

disappears should be of the Arduino board. Reconnect the board and select that serial port.

@ Blink | Arduino 1.06 =% SR 5=
File Edit Sketch [Tools| Help
Auto Format Ctrl+T

Archive Sketch

Sink§ Fix Encoding & Reload
Serial Monitor Ctrl+Shift+M n
Board: "Arduine Uno ¥
Senal Port ] Coml
USE Type v com2
PLU peed ’ CGME
I I dLa 1 3
Programmer *

Burn Bootloader

Step 8: Upload the program to your board.
Before explaining how we can upload our program to the board, we must demonstrate the

function of each symbol appearing in the Arduino IDE toolbar
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A- Used to check if there is any compilation error.

B- Used to upload a program to the Arduino board.

C- Shortcut used to create a new sketch.

D- Used to directly open one of the example sketch.

E- Used to save your sketch.

F- Serial monitor used to receive serial data from the board and send the serial data to the

board.

Now, simply click the "Upload" button in the environment. Wait a few seconds; you will see
the RX and TX LEDs on the board, flashing. If the upload is successful, the message "Done
uploading" will appear in the status bar.

Note: If you have an Arduino Mini, NG, or other board, you need to press the reset button
physically on the board, immediately before clicking the upload button on the Arduino
Software.
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CHAPTER 5

DESCRIPTION OF THE PROJECT
5.1 BLOCK DIAGRAM

Power

supply
ULTRA
sONIC it et
SENSOR T
GPS ARDUINO Node
module ATmeaga328 MCU Gemall
ESP32 | Leo
camera display

Fig 5.1: Block Diagram of Pothole Detection System

The working process begins with the ultrasonic sensor detecting road irregularities and
sending the data to the Arduino, which processes it and determines if a pothole is present.
The GPS module records the exact location, and the ESP32 camera captures an image of the
pothole. The processed information is then sent to the Node MCU, which transmits the
details via email. The LCD display provides instant feedback on the system’s status. This
automated system enhances road safety by efficiently detecting potholes and notifying

authorities for timely repairs.
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5.2 WORKING

The working procedure of the loT-based pothole detection system involves multiple steps,
integrating various electronic components to detect, alert, and document potholes
effectively. The process begins when the system is powered on using a 12V power supply,
initializing the connected components. The vehicle, controlled by a motor driver module,
starts moving forward while continuously scanning the road ahead using an ultrasonic
sensor. This sensor continuously measures the distance between the vehicle and the road
surface, detecting any sudden depressions or irregularities that indicate the presence of a

pothole.

Once a pothole is detected, the system immediately halts the vehicle's motion, providing an
instant alert to the driver or user. Simultaneously, an onboard LCD screen displays an alert
message indicating the presence of a pothole. This ensures that the driver is made aware of
road hazards in real time, allowing them to take necessary precautions. At the same time,
the system activates a Neo-6M GPS module, which accurately determines the geographical
coordinates (latitude and longitude) of the detected pothole. This data is essential for

recording the exact location of road damages for future maintenance efforts.

To facilitate remote monitoring, the GPS location data is transmitted wirelessly to a
designated Gmail account using the Node MCU module. This ensures that municipal
authorities, road maintenance teams, or other stakeholders receive real-time alerts about road
conditions, enabling prompt repair actions. Furthermore, the system integrates an ESP32

camera module, which provides live video streaming capabilities.

This feature allows users to visually inspect the road conditions in real time, offering
additional context alongside the GPS data. The Node MCU module facilitates the
transmission of the live video stream, making it accessible remotely via a connected device

such as a smartphone or computer.

Overall, the working procedure of the IoT-based pothole detection system ensures an
efficient and automated approach to identifying and reporting potholes. By leveraging a
combination of real-time alerts, GPS-based location tracking, and video streaming, the
system significantly enhances road safety and infrastructure management. Its ability to
detect potholes, halt vehicle movement, notify users, and transmit crucial data to authorities
makes it an effective solution for improving road conditions and reducing vehicle-related

damages due to poor infrastructure.
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5.3 INTRODUCTION TO ARDUINO

The Arduino is a family of microcontroller boards to simplify electronic design, prototyping
and experimenting for artists, hackers, hobbyists, but also many professionals. People use it
as brains for their robots, to build new digital music instruments, or to build a system that
lets your house plants tweet you when they’re dry. Arduinos (we use the standard Arduino
Uno) are built around an Atmega microcontroller — essentially a complete computer with

CPU, RAM, Flash memory, and input/output pins, all on a single chip.

Unlike, say, a Raspberry Pi, it’s designed to attach all kinds of sensors, LEDs, small motors
and speakers, servos, etc. directly to these pins, which can read in or output digital or analog
voltages between 0 and 5 volts. The Arduino connects to your computer via USB, where you
program it in a simple language (C/C++, similar to Java) from inside the free Arduino IDE

by uploading your compiled code to the board.

Once programmed, the Arduino can run with the USB link back to your computer, or stand-
alone without it — no keyboard or screen needed, just power. Arduino boards are
microcontroller-based platforms that enable users to create various electronic projects. The
most common board is the Arduino Uno, which features an ATmega328P microcontroller,
but there are several other models tailored for specific applications, such as the Arduino

Mega, Nano, and Leonardo.

$93210098 76543210
-4
€11 11 x %

Digital
USB

PWM2
PWM1
PWMO

Arduino §=

5 hnp//ardumoberllosde -. \J
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Fig 5.2: Structure of Arduino Board
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Looking at the board from the top down, this is an outline of what you will see (parts of the

board you might interact with in the course of normal use are highlighted)

C21 C20 C16
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-
e
e
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-
e
e
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3.3V 3. 3V GND GND [}
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82«:«:23‘
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Fig 5.3: Arduino Board
Starting clockwise from the top center:

o Analog Reference pin (orange)

o Digital Ground (light green)

o Digital Pins 2-13 (green)

o Digital Pins 0-1/Serial In/Out - TX/RX (dark green) - These pins cannot be used for

digital i/o (Digital Read and Digital Write) if you are also using serial communication (e.g.

Serial.begin).

(o) Reset Button - S1 (dark blue)

(o) In-circuit Serial Programmer (blue-green)

o Analog In Pins 0-5 (light blue)

o Power and Ground Pins (power: orange, grounds: light orange)

o External Power Supply In (9-12VDC) - X1 (pink)

o Toggles External Power and USB Power (place jumper on two pins closest to desired

supply) - SV1 (purple)
o USB (used for uploading sketches to the board and for serial communication

between the board and the computer; can be used to power the board) (yellow)
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Digital Pins

In addition to the specific functions listed below, the digital pins on an Arduino board can
be used for general purpose input and output via the pin mode(), Digital read(), and Digital
write() commands. Each pin has an internal pull-up resistor which can be turned on and off
using digital Write() (w/ a value of HIGH or LOW, respectively) when the pin is configured

as an input. The maximum current per pin is 40mA.

o Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.
On the Arduino Diecimila, these pins are connected to the corresponding pins of the FTDI
USB-to-TTL Serial chip. On the Arduino BT, they are connected to the corresponding pins
of the WTI11 Bluetooth module. On the Arduino Mini and LilyPad Arduino, they are
intended for use with an external TTL serial module (e.g. the Mini-USB Adapter).

o External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt
on a low value, a rising or falling edge, or a change in value. See the attach Interrupt(),
function for details.

o PWM: 3, 5, 6, 9, 10, and 11 Provide 8-bit PWM output with the analog write()
function. On boards with an ATmega8, PWM output is available only on pins 9, 10, and 11.
(o) BT Reset: 7. (Arduino BT-only) Connected to the reset line of the Bluetooth module.
(o) SPI: 10 (SS), 11 (MOSID), 12 (MISO), 13 (SCK). These pins support SPI
communication, which, although provided by the underlying hardware, is not currently
included in the Arduino language.

o LED: 13. On the Decimole and Lilypad, there is a built-in LED connected to digital
pin 13. When the pin is HIGH value, the LED is on, when the pin is LOW, it's off.

Analog Pins

In addition to the specific functions listed below, the analog input pins support 10-bit analog
to-digital conversion (ADC) using the analog Read() function. Most of the analog inputs can
also be used as digital pins: analog input 0 as digital pin 14 through analog input 5 as digital
pin 19. Analog inputs 6 and 7 (present on the Mini and BT) cannot be used as digital pins.

Power Pins

o VIN (sometimes labelled "9V"): The input voltage to the Arduino board when it's
using an external power source (as opposed to 5 volts from the USB connection or other

regulated power source). You can supply voltage through this pin, or, if supplying voltage
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via the power jack, access it through this pin. Also note that the Lily Pad has no VIN pin and
accepts only a regulated input.

o 5V: The regulated power supply used to power the microcontroller and other
components on the board. This can come either from VIN via an on-board regulator, or be
supplied by USB or another regulated 5V supply.

o 3V3 (Decimole-only) : A 3.3 volt supply generated by the on-board FTDI chip.

o Gnd: Ground pins.

Other Pins

o Aref: Reference voltage for the analog inputs. Used with analog Reference().

o Reset: (decimole-only) Bring this line LOW to reset the microcontroller. Typically

used to add a reset button to shields which block the one on the board.
Atmega328

The ATmega328 is an 8-bit microcontroller based on the AVR architecture. It is popular for
its balance of performance, power consumption, and ease of use, making it a favourite

among hobbyists and professionals for various electronics projects.

The ATmega328 can be programmed using the Arduino IDE, which simplifies the process
with a user-friendly interface and a set of libraries. Users typically write in a simplified
version of C/C++. The IDE also provides built-in functions that allow for easy interaction

with the microcontroller's hardware features.

The ATmega328 is widely used in various applications, including robotics, home
automation, and wearable technology, due to its versatility and compatibility with a wide
range of sensors and actuators. Its compact size and low power consumption also make it an

ideal choice for battery-powered projects and portable devices.

Overall, the ATmega328 is a powerful and versatile microcontroller that offers a unique
combination of performance, ease of use, and affordability, making it a popular choice

among electronics enthusiasts and professionals alike.
Pin Diagram
Pin Description VCC:

Digital supply voltage.
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GND:
Ground.
Port A (PA7-PAO):

Port A serves as the analog inputs to the A/D Converter. Port A also serves as an 8-bit
bidirectional I/O port, if the A/D Converter is not used. Port pins can provide internal pullup

resistors (selected for each bit)

Nt
(PCINT14/RESET) PCé ] 1 28 [1 PC5 (ADC5/SCL/PCINT13)
(PCINT16/RXD) PDO ] 2 27 |1 PC4 (ADC4/SDA/PCINT12)
(PCINT17/TXD) PD1 [ 3 26 [ 1 PC3 (ADC3/PCINT11)
(PCINT18/INTO) PD2 ] 4 251 PC2 (ADC2/PCINT10)
(PCINT19/0C2B/INT1) PD3 [} 5 2411 PC1 (ADC1/PCINT9)
(PCINT20/XCK/T0) PD4 [} 6 23 1 PCO (ADCO/PCINTS)
vecO7z 22 [1GND
GND L[]8 21 J AREF
(PCINT6/XTAL1/TOSC1) PB6 [} 9 20 [ AVCC

)
(PCINT7/XTAL2/TOSC2) PB7 [
(PCINT21/0CO0B/T1) PD5 [

)

)

)

-
o

191 PB5 (SCK/PCINTS5)

18 [ PB4 (MISO/PCINT4)

17 1 PB3 (MOSI/OC2A/PCINT3)
16 [ PB2 (SS/OC1B/PCINT2)
151 PB1 (OC1A/PCINT1)

-y
-t

(PCINT22/0CO0A/AINO) PD6 [
(PCINT23/AIN1) PD7 [C
(PCINTO/CLKO/ICP1) PBO [

[T S (|
S~ N

Fig 5.4: Pin Configuration of Atmega328

The Port A output buffers have symmetrical drive characteristics with both high sink and
source capability. When pins PAO to PA7 are used as inputs and are externally pulled low,
they will source current if the internal pull-up resistors are activated. The Port A pins are tri-

stated when a reset condition becomes active, even if the clock is not running.
Port B (PB7-PBO0):

Port B is an 8-bit bi-directional 1/O port with internal pull-up resistors (selected for each bit).
The Port B output buffers have symmetrical drive characteristics with both high sink and
source capability. As inputs, Port B pins that are externally pulled low will source current if

the pull-up resistors are activated. The Port B pins are tri-stated when a reset condition
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becomes active, even if the clock is not running. Port B also serves the functions of various

special features of the ATmega32.
Port C (PC7-PCO0):

Port C is an 8-bit bi-directional I/O port with internal pull-up resistors (selected for each bit).
The Port C output buffers have symmetrical drive characteristics with both high sink and
source capability. As inputs, Port C pins that are externally pulled low will source current if
the pull-up resistors are activated. The Port C pins are tri-stated when a reset condition
becomes active, even if the clock is not running. If the JTAG interface is enabled, the pullup
resistors on pins PC5(TDI), PC3(TMS) and PC2(TCK) will be activated even if a reset
occurs. The TDO pin is tri-stated unless TAP states that shift out data are entered.

Port D (PD7-PDO):

Port D is an 8-bit bi-directional I/O port with internal pull-up resistors (selected for each
bit). The Port D output buffers have symmetrical drive characteristics with both high sink
and source capability. As inputs, Port D pins that are externally pulled low will source
current if the pull-up resistors are activated. The Port D pins are tri-stated when a reset
condition becomes active, even if the clock is not running. Port D also serves the functions

of various special features of the ATmega32.
Reset (Reset Input):

A low level on this pin for longer than the minimum pulse length will generate a reset, even

if the clock is not running. Shorter pulses are not guaranteed to generate a reset.
XTALTL:

Input to the inverting Oscillator amplifier and input to the internal clock operating circuit.

XTAL2:
Output from the inverting Oscillator amplifier.
AVCC:

AVCC is the supply voltage pin for Port A and the A/D Converter. It should be externally
connected to VCC, even if the ADC is not used. If the ADC is used, it should be connected
to VCC through a low-pass filter.

AREF:
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AREF is the analog reference pin for the A/D Converter.
Features

1.8-5.5V operating range

Up to 20MHz

Part: ATMEGA328P-AU
32kB Flash program memory
1kB EEPROM

2kB Internal SRAM

2 8-bit Timer/Counters

16-bit Timer/Counter

RTC with separate oscillator
6 PWM Channels

8 Channel 10-bit ADC

Serial USART

Master/Slave SPI interface
2-wire (12C) interface
Watchdog timer

Analog comparator

23 10 lines

Data retention: 20 years at 85C/ 100 years at 25C

O O 0O O OO O OOOOOOO OO O O O

Digital I/O Pins are 14 (out of which 6 provide PWM output) ¢ Analog Input Pins
are 6.

(o) DC Current per I/O is 40 mA ¢ DC Current for 3.3V Pin is 50mA

5.4 INTRODUCTION TO ULTRASONIC SENSOR

The HC-SRO04 is a widely used ultrasonic sensor for distance measurement. It operates by
emitting ultrasonic waves at 40 kHz and measuring the time it takes for the echo to return
after bouncing off an object. With a distance range of 2-400 cm and an accuracy of +3 mm,
this sensor is ideal for various applications, including robotics, automation, proximity
sensing, and distance measurement. Its low power consumption of 15 mA and compact size
make it suitable for battery-powered applications. The HC-SR04 has several advantages,

including non-contact measurement, high accuracy, and low power and consumption.
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However, it also has some limitations, such as a limited range, potential interference from
other ultrasonic sources, and sensitivity to temperature and humidity. Despite these
limitations, the HC-SR04 is a reliable and affordable sensor widely used in various projects,

from DIY robotics to industrial automation systems.

Fig 5.5: Ultra Sonic Sensor

Specifications

Parameter Value

Operating Voltage 5V DC

Operating Current ~ 15mA

Ultrasonic Frequency 40 kHz

Measuring Range 2 cm —400 cm (0.02 m — 4 m)
Resolution 3 mm

Measuring Angle 15°

Trigger Input Signal 10us TTL pulse

Echo Output Signal TTL signal proportional to distance

Response Time ~750 ps - 20 ms
Dimensions 45mm x 20mm x 15mm
Working Principle

The Trigger pin receives a 10us HIGH pulse.

The sensor emits eight 40kHz ultrasonic pulses.

The sound waves reflect off an object and return to the Echo pin.

The Echo pin goes HIGH for a duration equal to the time taken by the sound waves to return.
Distance is calculated using the formula:

Distance=Time x Speed of Sound (343 m/s)2Distance = \frac {{Time \times Speed\ of\
Sound\ (343\ m/s)} } {2}

Pin Configuration
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Pin Function
VCC 5V power supply

Trig Trigger signal input (10us pulse)
Echo Receives the reflected signal

GND Ground

5.5 INTRODUCTION TO NEO 6M GPS MODULE

A complete GPS module with an active antenna integrated, and a built-in EEPROM to save
configuration parameter data. NEO 6m GPS module is one of the cheapest GPS modules in
the market and it is a very compact module that can be used into a small form factor system.
The GPS NEO 6M is a compact GPS receiver module manufactured by u-blox. It provides
accurate location data with high sensitivity and low power consumption. The module
supports various interfaces like UART, I2C, and SPI, making it suitable for robotics, drones,

automotive, and IoT applications.

Specifications

Built-in 25x25x4mm ceramic active antenna provides strong satellite search capability.
Equipped with power and signal indicator lights and data backup battery.

Power supply: 3-5V

Default baud rate: 9600bps.

Interface: RS232 TTL

Fig: 5.6 Neo 6m Gps Module
Advantages:
Compact Size: Ideal for space-constrained applications.
Multi-Interface Support: Compatible with UART, 12C, and SPI
Fast Time-To-First-Fix: Quickly acquires satellite signals.
Low Cost: Affordable compared to other GPS modules.

Wide Operating Temperature: Functional in extreme temperatures.
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5.6 INTRODUCTION TO ESP32 CAM

The ESP32-CAM is a development board that integrates an ESP32-S chip, an OV2640
camera, a microSD card slot, and several GPIOs to connect peripherals, making it an ideal

choice for 10T projects that require image and video capture, processing, and transmission.

The ESP32-S chip provides a powerful dual-core processor, Wi-Fi, and Bluetooth
connectivity, while the OV2640 camera offers a high-quality 2-megapixel resolution. The
microSD card slot allows for expandable storage, enabling users to store and retrieve images

and videos.

The ESP32-CAM also features several GP1Os, including digital input/output pins, analog
input pins, and UART, SPI, and 12C interfaces, providing a wide range of connectivity

options for peripherals such as sensors, displays, and actuators.

The ESP32-CAM supports a variety of image and video formats, including JPEG, BMP, and
MP4, making it suitable for applications such as home security systems, wildlife monitoring,

and industrial inspection.

Additionally, the board's small form factor and low power consumption make it an excellent

choice for battery-powered projects or applications where space is limited.

GPIO3 - IUDR
T — D

Fig 5.7: Esp 32 Camera
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Power Pins

The ESP32-CAM comes with three GND pins (colored in black color) and two power pins
(colored with red color): 3.3V and 5V.

You can power the ESP32-CAM through the 3.3V or 5V pins. However, many people
reported errors when powering the ESP32-CAM with 3.3V, so we always advise to power
the ESP32-CAM through the 5V pin.

Power output pin

There’s also the pin labeled on the silkscreen as VCC (colored with a yellow rectangle).
You should not use that pin to power the ESP32-CAM. That is an output power pin. It can
either output 5V or 3.3V.

In our case, the ESP32-CAM outputs 3.3V whether it is powered with 5V or 3.3V. Next to
the VCC pin, there are two pads. One labeled as 3.3V and other as SV.If you look closely,
you should have a jumper on the 3.3V pads. If you want to have an output of 5V on the VCC
pin, you need to unsolder that connection and solder the 5V pads.GPIO 1 and GPIO 3 are
the serial pins Because the ESP32-CAM doesn’t have a built-in programmer, you need to

use these pins to communicate with the board and upload code.

The ESP32 CAM Wi Fi Module Bluetooth with OV2640 Camera Module 2MP For Face
Recognization has a very competitive small-size camera module that can operate
independently as a minimum system with a footprint of only 40 x 27 mm; a deep sleep

current of up to 6mA and is widely used in various IoT applications.

It is suitable for home smart devices, industrial wireless control, wireless monitoring, and
other 10T applications. This module adopts a DIP package and can be directly inserted into
the backplane to realize rapid production of products, providing customers with high-
reliability connection mode, which is convenient for application in various [oT hardware

terminals.

ESP integrates WiF1i, traditional Bluetooth, and BLE Beacon, with 2 high-performance 32-
bit LX6 CPUs, 7-stage pipeline architecture. It has the main frequency adjustment range of
80MHz to 240MHz, on-chip sensor, Hall sensor, temperature sensor, etc.
Features:
e The smallest 802.11b/g/n Wi-Fi BT SoC module.
e Low power 32-bit CPU, can also serve the application processor.
e Up to 160MHz clock speed, summary computing power up to 600 DMIPS.
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e Built-in 520 KB SRAM, external 4MPSRAM.

e Supports UART/SPI/I2C/PWM/ADC/DAC.

e Support OV2640 and OV7670 cameras, built-in flash lamp.
e Support image WiFI upload.

e Supports TF card.

e Supports multiple sleep modes.

e Embedded Lwip and Free RTOS.

e Supports STA/AP/STA+AP operation mode.

e Support Smart Config/Air Kiss technology.

Specifications:

e External Storage: micro SD card slotup to 4GB.

e Expansion: 16x through-holes with UART, SPI, I2C, PWM.
e Misc: Reset button.

e Power Supply: 5V via pin header.
5.7 INTRODUCTION TO NODE MCU

The Node MCU is a cornerstone of modern Internet of Things (IoT) development, offering
a powerful and accessible platform for creating connected devices. At its core, the Node
MCU is an open-source software and hardware development environment built around the
ESP8266 Wi-Fi System-on-a-Chip (SoC), and later expanded to include ESP32 based

boards. This combination provides a robust foundation for a wide range of IoT applications.

ESP8266 NODE MCU
ESP8266-12E 3.3V Voltage Regulator IC

Wi-Fi Chip R EEEFEFF T EE D

De D1 D2 D:

Flash Button

: Micro USB
------- Connector

2.4GHz
Antenna

Reset Button

USB to TTL
Converter IC

Fig 5.8: Esp8266 Node MCU
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Hardware Features:

ESP8266/ESP32 SoC:

This is the heart of the Node MCU, providing the processing power, Wi-Fi connectivity, and
memory necessary for [oT tasks.

The ESP8266 and ESP32 both have their own strengths, with the ESP32 offering
significantly more processing power, memory, and additional features like Bluetooth.
Integrated Wi-Fi:

A key feature that enables seamless wireless communication, allowing devices to connect to
local networks and the internet.

GPIO Pins:

General-purpose input/output pins allow the Node MCU to interface with a variety of
external sensors, actuators, and other electronic components.

USB Connectivity:

A Micro-USB port is typically used for both powering the device and programming it.
Onboard Voltage Regulator:

This ensures a stable 3.3V power supply, which is essential for the ESP8266/ESP32 to
operate correctly.

Compact Design:

The Node MCU's small form factor makes it ideal for embedding in various projects.
Software Features:

Open-Source Firmware:

The Node MCU firmware is open-source, allowing for customization and community-driven
development.

Arduino IDE Compatibility:

One of the most significant advantages of the Node MCU is its compatibility with the
Arduino IDE. This makes it easy for developers of all skill levels to program the device
using the familiar Arduino language.

Lua Scripting:

Originally, the Node MCU firmware used the Lua scripting language, offering a flexible and
lightweight programming environment.

Wi-Fi Libraries:

Extensive libraries simplify the process of connecting to Wi-Fi networks, handling network
protocols, and communicating with web services.

IoT Protocols:
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The Node MCU supports various IoT protocols, such as MQTT, which enables efficient
communication between devices and cloud platforms.
In essence, the Node MCU has democratized IoT development by providing a low-cost,

easy-to-use platform with powerful capabilities.

Its combination of robust hardware, versatile software, and active community support has
made it a popular choice for hobbyists, makers, and professional developers alike. The
ability to quickly prototype and deploy connected devices has fueled innovation in areas

such as home automation, environmental monitoring, and industrial IoT.

The Node MCU's adaptability, driven by its open-source nature, ensures its continued

relevance in the ever-evolving landscape of connected technology.
5.8 INTRODUCTION TO L298N MOTO DRIVER MODULE

The L298N motor driver module is a popular and widely used component for controlling
DC and stepper motors. It's based on the STMicroelectronics L298N H-bridge integrated
circuit, designed to drive inductive loads such as relays, solenoids, and DC and stepper

motors.

Fig 5.9: L298N Motor Driver Module
Key Features:
Dual H-Bridge: The module features two independent H-bridges, allowing for bidirectional
control of two DC motors or a single stepper motor.
Voltage Range: It can handle motor voltages from 5V to 35V, making it versatile for various
motor applications. Current Capacity: Each H-bridge can deliver up to 2A of current,
although with a proper heat sink. It is important to note that without a proper heatsink, the

module will overheat and fail.
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Logic Voltage: The logic voltage for controlling the module is 5V, compatible with most
microcontrollers like Arduino and Raspberry Pi.

On-board 5V Regulator: Some modules include an on-board 5V regulator, allowing you to
power the logic circuitry from the motor power supply. However, this regulator is inefficient

and can cause overheating.

Enable Pins: Enable pins (ENA and ENB) allow for PWM (Pulse Width Modulation) speed
control of the motors.

Direction Control: Input pins (IN1, IN2, IN3, IN4) control the direction of motor rotation.
Screw Terminals: Screw terminals simplify connecting motor and power wires.

Heat Sink: Often includes a heat sink to dissipate heat, crucial for higher current
applications.

Pinout:

e VMS (Motor Supply Voltage): Connects to the motor power supply.

e GND (Ground): Common ground for motor and logic power.

e 5V (Logic Supply Voltage): Provides 5V for the logic circuitry.

e ENA (Enable A): Enables/disables motor A and allows for PWM speed control.

e IN1, IN2: Control the direction of motor A.

e IN3, IN4: Control the direction of motor B.

e ENB (Enable B): Enables/disables motor B and allows for PWM speed control.

e OUTI1, OUT2: Connect to motor A.

e (OUT3, OUT4: Connect to motor B.

Applications:

Robotics: Controlling the movement of robot wheels and arms.

CNC Machines: Driving stepper motors for precise positioning.

Automated Systems: Controlling linear actuators and other motor-driven components.

DIY Projects: Building motor-controlled devices and gadgets.

Important Considerations:

Heat Dissipation: The L298N generates significant heat, especially at higher currents. A heat
sink is essential.

Voltage Drop: The L298N has a voltage drop of around 2-3V, which can affect motor
performance.

Current Limitations: The module's current capacity is limited, and it may not be suitable for

high-power motors.
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Logic Levels: Ensure that the logic levels of your microcontroller are compatible with the
module's 5V logic.

5V Regulator issues: The on board 5V regulator is known to get extremely hot, and is not
recommended for powering external devices. It is better to power the logic side of the L298N
seperately.

Basic Operation:

To control a DC motor, connect the motor to OUT1 and OUT2 (or OUT3 and OUT4). Apply
logic signals to the IN1 and IN2 (or IN3 and IN4) pins to control the direction of rotation.
Use the ENA (or ENB) pin to control the motor speed via PWM.

This information provides a solid foundation for understanding and using the L298N

motor driver module.
5.9 INTRODUCTION TO LCD DISPLAY

An LCD (Liquid Crystal Display) is a flat-panel display technology commonly used in
electronic devices such as calculators, clocks, televisions, smartphones, and more. LCDs are
used to display text, images, and video through the manipulation of liquid crystals that
modulate light. The display works by passing light through or reflecting it from a liquid
crystal matrix, depending on whether the display is transmissive or reflective. LCDs have
become the standard in many applications due to their versatility, power efficiency, and

ability to offer clear, sharp images.

This is 3 2xl6

line LCD Dizrlas |

Fig 5.10: LCD Display
Working Principle:
LCDs work on the principle of controlling the alignment of liquid crystals in response to an

electric current, which in turn controls the light passing through them.
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Twisted Nematic (TN): Most common LCD technology, where the liquid crystals twist when
an electric current is applied, allowing light to pass through.

In-Plane Switching (IPS): Offers better color accuracy and viewing angles by aligning liquid
crystals parallel to the display surface.

Types of LCD Displays:

Monochrome (Black and White): Displays text or basic graphics using two colors.

Color LCDs: Displays full-color images, often used for screens in smartphones, TVs, and
computer monitors.

LED-Backlit LCDs: These are a form of LCD that uses LEDs to provide backlighting. These
are more energy-efficient and can achieve brighter displays than traditional fluorescent-lit
LCDs.

Size and Resolution:

Size: LCDs are available in a wide range of sizes. For instance, small modules are available
for use in devices like clocks or handheld electronics, while larger panels can be used in TVs
or digital signage. Sizes range from small (e.g., 16x2 characters for simple display modules)
to large (e.g., 55 inches or more for TVs and monitors).

Resolution: The resolution is the number of pixels (picture elements) the display can show.
A higher resolution means sharper images.

Common resolutions include:

HD (1280x720 pixels)

Full HD (1920x1080 pixels)

4K (3840x2160 pixels)

Applications:

Consumer Electronics:

Smartphones, Tablets, and Laptops: LCDs serve as the primary screen for these devices,
providing sharp and vibrant displays.

Televisions: LCD technology, particularly with LED backlighting, is used in most modern
flat-screen TVs.

Industrial Applications:

Digital Signage: Large-format LCDs are used for displaying advertisements, news, and
information in public spaces such as airports, shopping malls, and stadiums.
Instrumentation Displays: LCDs are used in medical equipment, scientific instruments, and
other devices requiring data visualization.

Consumer Appliances:
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Microwave Ovens, Refrigerators, and Smart Home Devices: LCDs are used for user
interfaces, making them easier to operate.

Car dashboards, infotainment systems, and navigation devices often use LCDs for clear,
easy-to-read displays.

Advantages:

Low Power Consumption

Compact and Lightweight

Sharp Image Quality

Cost-Effective.

5.10 INTRODUCTION TO POWER SUPPLY

Step down Bridge Filter Regulator Output

Rectifier

Transformer

Fig 5.11: Schematic diagram of Power Supply

The input to the circuit is applied from the regulated power supply. The a.c. input i.e.,
230V from the mains supply is step down by the transformer to 12V and is fed to a rectifier.
The output obtained from the rectifier is a pulsating d.c voltage. So in order to get a pure
d.c voltage, the output voltage from the rectifier is fed to a filter to remove any a.c
components present even after rectification. Now, this voltage is given to a voltage

regulator to obtain a pure constant dc voltage. regulator to obtain a pure constant dc

voltage.
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Fig 5.12: Block Diagram of Power Supply
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Step down Transformer:
Usually, DC voltages are required to operate various electronic equipment and these voltages

are 5V, 9V or 12V. But these voltages cannot be obtained directly.

Thus the a.c input available at the mains supply i.e., 230V is to be brought down to the
required voltage level. This is done by a transformer. Thus, a step-down transformer is

employed to decrease the voltage to a required level.

Rectifier:

The output from the transformer is fed to the rectifier. It converts A.C. into pulsating D.C.
The rectifier may be a half wave or a full wave rectifier. In this project, a bridge rectifier is
used because of its merits like good stability and full wave rectification.

Filter:

Capacitive filter is used in this project. It removes the ripples from the output of rectifier and
smoothens the D.C. Output received from this filter is constant until the mains voltage and
load is maintained constant. However, if either of the two is varied, D.C. voltage received at
this point changes. Therefore a regulator is applied at the output stage.

Voltage Regulator:

As the name itself implies, it regulates the input applied to it. A voltage regulator is an
electrical regulator designed to automatically maintain a constant voltage level. In this
project, power supply of 5V and 12V are required. In order to obtain these voltage levels,
7805 and 7812 voltage regulators are to be used. The first number 78 represents positive
supply and the numbers 05, 12 represent the required output voltage levels.

Features:

* Output Current up to 1A.

* Output Voltages of 5, 6, 8, 9, 10, 12, 15, 18, 24V.

* Thermal Overload Protection

* Output Transistor Safe Operating Area Protection.
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CHAPTER 6
RESULTS AND DISCUSSION
6.1 RESULTS

The implemented IoT-based pothole detection system successfully integrates various
electronic components to create a vehicle-mounted solution for identifying and reporting
road surface irregularities. Upon the application of a 12V power supply, the system
initializes, and the vehicle, controlled by a motor driver module, commences forward
movement. The core functionality hinges on the continuous operation of an ultrasonic

sensor, which actively scans the road ahead for potential potholes.

The system's primary objective is triggered upon the detection of a pothole by the
ultrasonic sensor. This event initiates a series of actions aimed at alerting the user and
documenting the pothole's location. Firstly, the system halts the vehicle's forward motion,
providing an immediate indication of a detected hazard. Simultaneously, an alert message
is displayed on an onboard LCD screen, providing a local notification to the vehicle's

occupants.

Crucially, the system leverages a Neo-6M GPS module to accurately determine the
geographical coordinates of the detected pothole. This location data is then transmitted
wirelessly to a designated Gmail account via the Node MCU module, enabling remote

monitoring and data collection.

This email notification serves as a critical alert, providing valuable information about the

pothole's location for potential road maintenance or safety interventions.

Furthermore, the system incorporates an ESP32 camera module, offering the capability for
live video streaming. This feature allows for real-time visual inspection of the road
conditions, potentially providing additional context and information alongside the GPS
coordinates. The live stream is also facilitated by the Node MCU module, enabling users to

access the video feed remotely via a connected device.

The project demonstrates a practical application of IoT technologies for enhancing road
safety and infrastructure management. By integrating sensors, communication modules, and

data processing capabilities, the system effectively automates the detection and reporting of
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potholes, providing valuable real-time information that can contribute to more efficient road

maintenance and a safer driving environment.

The combination of local alerts, precise location tracking, and optional live video streaming

offers a comprehensive approach to addressing the common issue of potholes on roadways.

Fig 6.1: Pothole Detection Model Kit
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Fig 6.2: Output
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6.2 ADVANTAGES

One of the major advantages of an [oT-based pothole detection system is its ability to provide
real-time monitoring and alerts. The system uses sensors, GPS to detect potholes and
transmit data to concerned authorities instantly. This immediate reporting helps in prompt
road repairs, preventing further deterioration and reducing maintenance costs. Early
detection also prevents minor cracks from expanding into severe potholes, thereby

prolonging the lifespan of roads.

Additionally, IoT-based systems contribute to improved vehicle safety and accident
prevention. Potholes are a major cause of vehicle damage, leading to tire blowouts,

suspension problems, and even accidents.

By integrating this system with navigation apps and smart vehicles, drivers can receive
alerts about potholes ahead, allowing them to take necessary precautions. This significantly

reduces the risk of accidents, improves driving comfort, and enhances overall traffic safety.

Another key benefit is the cost-effectiveness and efficiency of road maintenance.
Traditional road inspection methods require a lot of manpower and time. In contrast, an loT-
based system automates data collection and analysis, reducing operational costs for

municipal authorities.

The system helps in prioritizing road repairs based on the severity and frequency of pothole
occurrences, allowing for better resource allocation. Predictive analytics can further

optimize maintenance schedules, leading to more sustainable infrastructure management.

Furthermore, IoT-based pothole detection contributes to smart city initiatives. With
urbanization on the rise, governments and municipalities are increasingly investing in smart
infrastructure solutions. Integrating pothole detection into a city's [oT ecosystem enhances
urban planning, improves public transportation efficiency, and fosters a safer environment

for pedestrians and cyclists.

The collected data can also be utilized for traffic flow analysis and urban development,
leading to better decision-making and road network optimization. From an environmental
perspective, this system helps reduce the carbon footprint associated with road repairs. By
addressing potholes promptly, authorities can minimize the excessive use of construction

materials, fuel, and labor.
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Additionally, smoother roads result in improved fuel efficiency for vehicles, reducing
emissions and contributing to a greener environment. Lastly, IoT-based pothole detection
systems enhance citizen engagement and satisfaction. Many systems allow users to report
potholes via mobile applications, fostering community participation in urban maintenance.
Transparent and efficient road management increases public trust in government authorities,

as citizens can see tangible improvements in road conditions.

6.3 APPLICATIONS

One of the significant applications of loT-based pothole detection is in smart city
infrastructure management. City authorities can utilize real-time road condition data to
optimize maintenance schedules, ensuring that potholes are fixed before they cause severe

damage or accidents.

The system also helps in data-driven urban planning, allowing governments to allocate
resources effectively based on road quality insights. By integrating this technology into
smart city ecosystems, authorities can enhance public safety and extend the lifespan of road

networks.

Another critical application is in vehicle safety and accident prevention. IoT-enabled
pothole detection systems can send real-time alerts to drivers, helping them avoid hazardous
road conditions. This is particularly beneficial for autonomous vehicles, which rely on
precise data for safe navigation. By reducing the risk of accidents caused by potholes, these

systems contribute to overall road safety and help prevent costly vehicle repairs.

For logistics and fleet management, loT-based pothole detection provides valuable insights
for optimizing delivery routes. Logistics companies can use this data to plan smoother and
safer routes, minimizing delays and reducing vehicle wear and tear. This is especially crucial
for industries reliant on heavy transportation, as avoiding damaged roads can significantly

lower maintenance costs and improve operational efficiency.

The insurance industry can also benefit from IoT-based pothole detection systems through
risk assessment and claim verification. Insurance providers can use road condition data to
determine premiums, rewarding drivers who operate in well-maintained areas. Additionally,
in the event of an accident, this data can serve as crucial evidence to validate insurance

claims, reducing fraudulent cases and ensuring fair compensation.
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IoT-powered pothole detection also plays a vital role in disaster management and
emergency response. After natural disasters such as earthquakes or floods, authorities can
quickly assess road damage and prioritize repairs. Emergency services, such as ambulances
and fire trucks, can use real-time pothole data to navigate safely and reach affected areas

faster, ultimately saving lives.

Furthermore, these systems can enhance citizen engagement and crowdsourcing efforts.
Mobile apps integrated with IoT-based pothole detection allow residents to report road
issues, fostering community participation in infrastructure development. This data can be
shared with municipal authorities, ensuring prompt action and better collaboration between

governments and citizens in maintaining road quality.
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CHAPTER 7

CONCLUSION AND FUTURE SCOPE
7.1 CONCLUSION

In conclusion, the implemented loT-based pothole detection system provides an efficient
and automated solution for identifying and reporting road surface irregularities, contributing
to improved road safety and infrastructure management. By integrating an ultrasonic sensor
for pothole detection, a Neo-6M GPS module for precise location tracking, and a Node MCU
module for wireless data transmission, the system ensures real-time monitoring and

reporting of road hazards.

The addition of an onboard LCD for immediate alerts and an ESP32 camera module for live
video streaming further enhances the system’s functionality by providing visual verification
of road conditions. This comprehensive approach allows for timely intervention by
authorities, reducing vehicle damage, enhancing driver safety, and optimizing road

maintenance efforts.

The system's ability to wirelessly transmit pothole data via email ensures remote
accessibility, making it a valuable tool for smart city applications. By leveraging IoT
technologies, this project demonstrates a scalable and practical solution that can be deployed

in various vehicle types, ultimately contributing to safer and well-maintained roadways.
7.2 FUTURE SCOPE

The future scope of the IoT-based pothole detection system is vast, with several potential
advancements and applications that can enhance its effectiveness and scalability. One
significant improvement could be the integration of machine learning and artificial

intelligence (Al) to analyse road conditions more accurately.

By training Al models on large datasets of road images and sensor data, the system can
differentiate between potholes, speed bumps, and other road anomalies, reducing false
positives and improving detection accuracy. Additionally, the incorporation of LiDAR
sensors alongside ultrasonic sensors can provide more precise depth and dimension analysis

of potholes, leading to better decision-making for road maintenance.

Another key area of development is the use of edge computing to process data locally before

transmission, reducing latency and making real-time alerts more efficient.
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Enhancing the communication capabilities by incorporating 5G networks can also
significantly improve the system's ability to transmit data faster and support high-resolution

video streaming for better remote analysis.

Beyond technical advancements, the system can be expanded into smart city infrastructure
by integrating it with municipal databases and road maintenance management systems. By
creating a centralized platform that collects and visualizes pothole data from multiple
vehicles, city planners and transportation departments can prioritize road repairs based on

real-time and historical data analytics.

Crowdsourcing models can also be implemented, allowing regular vehicles, public
transport, and even ride-sharing services to contribute pothole detection data, creating a

collaborative road monitoring network.

Additionally, the system can be adapted for autonomous vehicles, helping self-driving cars
navigate hazardous roads more safely. With further refinements, the technology can also be
used for road quality assessment in rural and underdeveloped areas, where infrastructure

maintenance is often overlooked.

As governments and organizations increasingly invest in smart transportation solutions, the
IoT-based pothole detection system holds immense potential for improving road safety,

reducing vehicle maintenance costs, and ensuring smoother traffic flow in the future.
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APPENDIX

Appendix-1: Gather Components

Before beginning the project, ensure you have all necessary components:

—

. Arduino

. Ultrasonic Sensor

. NEO-6M GPS Module

. ESP32 Camera

. Node MCU

. L298N Motor Driver Module
. LCD Display

. Power Supply

O 0 3 O N B~ W DN

. Jumper Wires, Breadboard, Resistors
Appendix-2: Circuit Design & Wiring
2.1 Arduino & Sensor Connections
1. Ultrasonic Sensor — Connects to Arduino’s digital pins to measure road surface distance.
2. GPS Module (NEO-6M) — Connects to Arduino via UART (TX/RX) for location
tracking.
3. ESP32 Camera — Connects to Node MCU for capturing pothole images.
4. LCD Display — Connects via I2C or SPI for displaying real-time information.
5. Motor Driver (L298N) — Connects to Arduino to control the movement of the vehicle.
6. Power Supply — Ensures all modules receive the appropriate voltage.
2.2 Power Distribution
«  Ensure a stable power supply for all components, including sensors and the motor
driver.
«  Consider using a backup battery to keep the system operational in case of power
failure.
Appendix-3: Setting Up the ESP32, Arduino, Node MCU Environment
Appendix-4: Writing the Firmware for Arduino, ESP32, and Node MCU.
Appendix-5: Testing the System.
Appendix-6: Installing the System in Vehicle
Appendix-7: Final Testing & Optimization

Appendix-8: Monitoring and Maintenance
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